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EKRASMS

The EKRASMS software package is designed to monitor, configure and control IEDs of
BE2704/ED7, BE2502/ED5 and BE2702(M) series, and integrate them into the Process Control
System (PCS). The package supports all ever manufactured types and versions of the indicated
series of [EDs.

EKRASMS software package is a distributed system designed for operation in a network.
Nevertheless, it can be fully used on one computer as well.

EKRASMS operation requires a computer running Microsoft Windows XP and newer
operating system.

In order to install EKRASMS on a computer, open EKRASMS installation file and follow the
instructions of the installation wizard.

When describing work with EKRASMS applications, in order to save paper, screenshots of windows are
not provided. Therefore, it is recommended to run applications on a computer in parallel with the
study.
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1 INTRODUCTION TO EKRASMS

1.1 APPLICATIONS AND SERVICES

The EKRASMS package consists of applications and services.

— An application is a program with which a user interacts through its user interface. You
must be logged in to Windows to start the application;

— A service is a stand-alone program that does not have a user interface that starts
automatically with the operating system and does not require logging in to Windows.

Services within EKRASMS are divided into two types:

— User-type - implement a certain part of the autonomous functions of the system, which
the user has the ability to configure, maintain, and also enable and disable at will. For example,
the function of automatically creating a backup copy of the event database may not be used at all
within a particular computer, or it may be used with very specific operating parameters. User
services are set up in the Arsenal application.

— System-type - implement system-wide mechanisms.

Applications Communication server, Data archiving server, Oscillogram server, as well as all gateways
to various PCS standards are fundamentally identical to user services, however, while they are
implemented as applications, not services, therefore, in order to work with them, you must log in to
Windows. These applications are not configured with Arsenal. Each of them has its own user interface
for configuration.

User services fall into two categories:

— Services that provide some functionality to other services and applications, including
over a network. Such services are commonly referred to as server services;

— Services that use functions provided by server services. Such services are commonly
referred to as client services.

This classification is introduced only in relation to ERKASMS system, because a service that is a client
from the point of view of EKRASMS can simultaneously act as a server of some other system (for
example, gateways of standard communication protocols) and vice versa.

1.2 SERVERS AND WORKSTATIONS

The EKRASMS package is a network one, i.e. system functions can be distributed across
multiple computers in the network. There are typically two categories of computers: Servers and
Workstations.

— EKRASMS server is a computer that, after preconfiguration, works autonomously and
continuously. The server runs a certain set of EKRASMS services (as well as server applications),
the composition of which determines its essence. It can be a device access server, a database
server, etc. The server can also perform all the autonomous functions that are part of EKRASMS;

— EKRASMS workstation is a user's computer where EKRASMS applications are started.
Depending on the job responsibilities of the user, these can be applications for monitoring IEDs,
their maintenance or analysis of the information they collect.
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The introduction of the concepts of Server and Workstation is very conditional and is

done for the convenience of presentation. The EKRASMS package is always installed on each
computer as a whole, so the computer can be used both as a server and as a workstation at the
same time. However, it is recommended to use an industrial PC to act as a standalone server.

The figure shows a possible arrangement of EKRASMS with one device access server, one

data storage server, one data backup server and one workstation.

Workplace

Monitoring
program

—

-

— — —

Tickets

A

Timeline

f
7

rvice -
L i

SPACE se|

—

z

sel

GOLIATH

BACKU
rvice

service

Database
backups

[

\

Data server

AN
~
Device server

»
\ SPACE service A \ SPACE service
! \
"""""""""""" : GOLIATH
Al GOLIATH service [ | ARCHIVE
o service 8 service
- [ B —
\L __| | 1EC870-5-103 [~ Data archiving - o
[ g : =)
gateway y [—> server
! C ication § -
\ 4 J_ server
Lot OPC server | Oscillogram // Database
) server
I I Oscillograms Controk
532702 | 532704 | 532502 Events Messag




2 ARSENAL. SERVICES CONTROL

The Arsenal application makes changes to the operating system settings and, as a result, requires that
it be launched as the administrator. Therefore, under Windows Vista and above, when the application
is launched, the Windows User Account Control (UAC) window is displayed to confirm or elevate
privileges. Under Windows XP, the application itself will check the privilege level of the actual user of
the operating system and, if there are not enough privileges, will inform you about the need to launch
it manually as the administrator.

2.1 FUNCTION

The Arsenal application is designed to control EKRASMS services.

Applications Communication server, Data archiving server, Oscillogram server, as well as all gateways
to various PCS standards are still implemented as applications, not services, so their own user interface
is used to control them.

2.2 SERVICES PAGE

The Services page contains a list of user services. Each service has an Start/Stop button. In
the stopped state, the service menu button is additionally available, which allows you
configuring it, as well as performing other interactive actions related to it. The composition of
this menu is different for each service and will be discussed in the sections of their description.

After the initial installation of EKRASMS, in order to simplify work in the most typical use cases, some
user services are automatically enabled. If you do not need the functions of these services, please
disable them in Arsenal.

2.2.1 SENDING E-MAIL

Some EKRASMS services and server applications can send e-mail messages (for example,
the Goliath service can send system notifications by e-mail). In order for them to be able to send
messages, you need to configure the EKRASMS mail subsystem by clicking on the Setup mail
button.

The EKRASMS mail subsystem can send mail either directly through a mail (SMTP) server
or redirect it to be sent from another computer.

Redirection is necessary when it is required to send messages via a mail server located on the
Internet, if the computer from which the sending is performed does not have Internet access.
Redirection allows you setting up the actual sending of e-mails from another computer in the local
network that has Internet access and then use it as an intermediary.

2.2.1.1 SENDING VIA MAIL SERVER

To directly send e-mails to a mail server in the Mail sending options window, you must
select the Send mail from this computer option.

The parameters to be configured are the same as those in any mail program and their
values depend on the mail server you have selected.
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If a corporate mail server is used, the required settings can be obtained from the administrator of this
server; if a public server on the Internet (Yandex, Google, etc.) — on the corresponding site in the Help
section.

2.2.1.2 E-MAIL REDIRECTION

To send e-mails via redirection, in the Mail sending options window, select the Redirect
mail to another computer option. The parameters specify the address of the computer (for
details, see paragraph 3.1.2), which will act as an intermediary in sending mail, as well as the
parameters for remote login (for details, see paragraph 2.3) to it.

To organize redirection on the intermediary computer, you need to install EKRASMS,
configure the mail subsystem as described in paragraph 2.2.1.1, and start the Fork redirection
server in Arsenal.

2.2.2 SERVICES LANGUAGE

Services require a language for generating user notifications, composing e-mails, and a
number of other uses. It is set in the Services language drop-down list at the bottom of the
application window.

After the initial installation of EKRASMS, the language of services corresponds to the language of
Windows. EKRASMS only supports English and Russian, so if Windows is running in any language other
than Russian, EKRASMS will run in English. Subsequent updates to EKRASMS retain the selected
language value.

2.3 ACCESS PAGE

Access to server services from client services over the network, as well as from
applications, both over the network and within the same computer, requires user authorization.
EKRASMS provides the ability to configure a list of users to control access to server services on
the computer.

EKRASMS implements a group model. Users belonging to the same group have their own
username and password, but common access rights to server services. Access rights to a
particular service are discussed in their description sections.

The list of groups and users is the same for all server services (and communication
server) and is configured on the Access page.

Local connections of client services and applications to server services are always possible,
while client connections from other computers can be enabled or disabled. To do this, at the
bottom of the Access page there is a Remote access control area.

After the initial installation of EKRASMS, remote access is denied. With subsequent updates of
EKRASMS, the state of remote access is preserved.
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3 SERVICES

3.1 SYSTEM SERVICES

3.1.1 SATELLITE

It implements the mechanism of interprocess communications between EKRASMS
services and applications. It is started automatically when needed. There is no explicit control of
the service. It does not require settings.

3.1.2 SPACE

It implements a mechanism for remote access to a computer. The service is controlled in
the Remote access area of the Arsenal Access page.

This is the only EKRASMS service that opens a TCP port for listening. The default port
value is 11111. We recommend that you leave this value unchanged.

When configuring client applications and services, you must enter the IP address or network name of
the server in the Address field, depending on how your particular network functions. If the EKRASMS
remote access port on this server is different from the standard one (11111), then after the address
you need to put the symbol “:” (colon) and add the number of the non-standard port. For example:
192.168.1.1:12000 or ivanov_ii:11500

3.2 GOLIATH. DELIVERY OF SYSTEM MESSAGES

3.2.1 FUNCTION

The services do not have their own user interface and run without loading the Windows
desktop, so when they have any events that need to be reported to the user, they send EKRASMS
system messages. The mechanism for sending system messages is always available to any
service and does not require any actions on the part of the user to activate and configure it.

The Goliath service gives the user the ability to receive messages sent by other services in
two ways:

— Sending them to specified addresses as e-mails (access to the mail server is required on
the server computer);

— Acting as an access server to them (including over the network) for the Tickets
application, which displays them on the user's desktop.

The Goliath service is only required to deliver messages sent by other services to the user. Sending and
storing messages is not related to Goliath. Therefore, by temporarily stopping the Goliath service, you
will not lose messages that will be sent during its period of inactivity. The exception is the disabling of
the Goliath service for 3 days or more, because during this time, messages that users have not yet
received may expire.
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3.2.2 MENU
Item Description
Mailing list" Configuring a list of mailing addresses for sending messages by mail

1) - As this is the only menu item, it is executed immediately after pressing the service menu button.

3.2.3 SENDING MESSAGES BY MAIL

I To send messages by e-mail, you must configure the mechanism for sending mail (see paragraph
2.2.1).

When the service is running, all addresses on the mailing list begin receiving e-mail
containing the messages sent by the services.

To avoid spamming target mailboxes, the Goliath service pauses between sending e-mails. Therefore,
one letter can contain several messages at once.

3.2.4 TICKETS. DISPLAYING MESSAGES ON DESKTOP

The Tickets application allows you to collect messages from multiple EKRASMS servers at
once by connecting to the Goliath service on those computers.
Once started, the Tickets application is located in the Windows Taskbar.

If necessary, in the application settings, you can enable/disable automatic launch when the user logs
into Windows.

The application icon menu in the taskbar consists of the following items:

Item Description
Show Display the main window of the application

Setting the notification method for received messages and enabling/disabling the

Settings . N
automatic start of the application

Quit Shutdown of the application

The main Tickets window consists of two parts. The list of servers from which messages
are being collected is located on the left side, and the messages received from the selected server
are displayed on the right side.

The first in the list of servers is This computer, which cannot be deleted, but can only be
disabled if messages from the services of the local computer are not of interest (for example, if
your computer is a workplace and no server services are running on it).

To add a collection of messages from another server, you must click the Add button under
the list of servers.

To connect to the Goliath service on another computer, you must provide a username and password.
The user must be registered with Arsenal on the target computer and be a member of a group that has
the Read messages right in the Goliath section.
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Each server in the list has a menu button consisting of the following items:

Item Description
Clear Clearing the list of received notifications

Disable/Enable

e Denying and allowing notifications about new messages from this server
notifications

Disable/Enable” Disabling and enabling the collection of messages from the local computer
Edit” Editing server login options
Remove” Removing a server from the list

1 - only for This computer
2) - for all servers except This computer

3.3 ARCHIVE. ACCESS TO EVENT DATABASE

3.3.1 FUNCTION

The Archive service is the EKRASMS event database server. Through it, services and
applications can add events to the database and read them from it.
It is possible to implement various scenarios for collecting events:

— Each Device access server maintains its own local event database. This option is good
because the ability to collect does not depend on the state of the local network of the enterprise,
because all work takes place within one computer.

— All device access servers send events to a single database on a dedicated computer.
This is convenient for subsequent analysis of the collected data, but in case of problems in the
local network of the enterprise, the collection of events may be interrupted, which can lead to
the loss of events due to the overflow of recorders in the IEDs.

— A mixed scenario is also possible.
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3.3.2 MENU
Item Description
Save database to file Saving the database as a file (*.archive)

Restoring a database from a database file (*.archive). The actual

Restore database f fil . . .
estore database trom file database is deleted in this case

Removing events older than some (optional) point in time from

Remove old events
the database

Clear database Clearing the entire database

Import of events from a database saved in an *archive or

Import database from file * .dbbackup file to the actual database

Import of oscillograms from the folder (and all subfolders) where
they are collected by the Oscillogram server into the actual
database

Import oscillograms from
Oscillogramm server

Import of oscillograms from a user-specified folder (and all

Import oscillograms from folder
P & subfolders) into the actual database

Allows you performing the following operations with the old

database:

- Import data into the actual database and delete the old database
Actions on old database” from the disk;

- Save old database to *dbbackup file and delete old database

from disk

- Remove old database from disk

1) - The item is available only if the database of EKRASMS 2.13 (or older) is found on the disk

3.4 BACKUP. BACKING UP EVENT DATABASE

3.4.1 FUNCTION

The Backup service allows you to back up EKRASMS event databases. It periodically
connects to the Archive service of the backed up computer and synchronizes the actual state of
the database with its backup. It is possible to back up the database of both your own computer
and other computers on the network.

To connect to the Archive service from another computer, you must provide a username and
password. The user must be registered with Arsenal on the target computer and belong to a group that
has the Read events right in the Archive section.

The Backup service allows you to simultaneously back up multiple databases from
different computers in the network. You can also run this service on multiple computers to make
multiple backups of the same database.

If during the next synchronization session it is detected that the database on the computer being
backed up has been changed by clearing, removing outdated events, or restoring from a file, the
Backup service saves the actual state of its backup as a file (*.archive) in the archive directory, deletes
the backup and restarts synchronization.
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3.4.2 MENU

Item Description

Setup Setting a list of servers the databases of which should be backed up
Manage Deleting and saving backups as a file (*.archive)
Archives Opening the Explorer application window in the archive folder

3.5 FORK. REDIRECTION

3.5.1 FUNCTION

The Fork service acts as a server for redirecting the execution of tasks. Redirection is
needed mainly in cases where the task requires Internet access, which is not available on the
computer that must complete the task. At the same time, the required access is on some other
computer in the local network. With Fork, you can delegate the execution of a task to a computer
that, under specific conditions, can successfully complete it.

I Currently, only sending e-mail can be redirected (see paragraph 2.2.1)
The Fork service does not require setting.

To connect to the Fork service on another computer, you must provide a username and password. The
user must be registered with Arsenal on the target computer and belong to a group that has been
granted the Redirection right in the Fork section.

3.6 EKRASMS.INI FILE

3.6.1 FUNCTION

The EKRASMS.ini file is designed to fine-tune the operation of services. It contains a
number of parameters that cannot be changed in the Arsenal application.

The EKRASMS.ini file must be located in the folder:
%ALLUSERSPROFILE%\EKRA\EKRASMS

To navigate to the specified folder, copy the entire string into the Explorer application path field and
press Enter.

After installing EKRASMS on a computer, the EKRASMS.ini file is not created in the
specified folder, and all parameters that may be in it are considered to be equal to the standard
values.

If you need to set a value other than the standard value for some parameter, you must:

— create the EKRASMS.ini file in the specified folder (if you have not created it before);
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—in the Notepad application or other similar text editor, add strings with the required
parameter values to the file;

— save changes;
— restart the Arsenal application;

— restart dependent services in the Arsenal application.

3.6.2 UsE

EKRASMS.ini is a text file. Each parameter is described on a separate line in the following
format:

<Parameter name>=<Parameter value>

For convenience, the parameters are divided into sections. The beginning of a new
section is described on a separate line in the following format:

[<Section name>]

Example:

[Folders]
ArchiveRoot=D:\Archive

The case of characters in the names of parameters and sections does not matter.

u.n

Lines the first significant character of which is “;” (semicolon), are skipped.

3.6.3 FOLDERS SECTION

In the Folders section, you can override the folder paths used by various services to store
data. The table lists all supported parameters, each with a description and a standard value that
is used if the parameter is not set in the file, as well as the service that uses it.

Parameter Description Service

. Folder for storing event database
ArchiveRoot" Archive
Standard value: %ALLUSERSPROFILE%\EKRA\EKRASMS\Archive

. Folder for storing backup and archive copies of event databases
BackupRoot ) Backup
Standard value: %ALLUSERSPROFILE%\EKRA\EKRASMS\Backup

1) - The folder must be located on a fixed local hard drive and not belong to the Windows user profile under which
setting is being performed, otherwise the service may not be able to access it
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4 SERVER APPLICATIONS

4.1 COMMUNICATION SERVER

4.1.1 FUNCTION

Communication Server directly interacts with IEDs of the BE2704/ED7, BE2502/ED5 and
BE2702(M) series and grants access to connected IEDs for other EKRASMS services and
applications.

After the Communication Server is fully configured, intervention in its operation is usually
not required: all settings are saved in the Windows registry and configuration files and are
automatically applied the next time the Communication server is loaded. The Communication
server runs in the background: it is configured and controlled using the commands of the main
menu of the Communication server (accessible by right-clicking on the Communication server icon
on the Windows taskbar, which is usually located in the lower right corner of the screen). If you
hover your mouse over this icon, the state of the Communication server will be displayed.

4.1.2 USERS AND ACCESS RIGHTS

Users and groups are managed in the Arsenal application (see paragraph 2), so the Main
menu - Users command simply starts Arsenal.
When installing EKRASMS, the following user groups are automatically created:

Group Access rights to communication server

Reading data
Change settings
RPA engineers Clear oscillogram memory
Start oscilloscope
Reset alarm

Reading data

PCS engineers Change settings
Reset alarm
Readi
Operators eading data
Reset alarm
Generic users Read data

During the initial configuration of the Communication server, you need to create a list of
users who will be allowed access to [ED data.

17



EKRASMS

4.1.3 CONNECTION OF IEDsS

By executing Main menu - Settings command, the settings window of the Communication
server appears. Depending on how the IEDs are connected, the Connection type should be set.

Standard options for connecting IEDs:

Connection

COM port of computer is connected to RS232 front
port of the IED

USB port of computer is connected to RS232 front

port of the IED
Using the USB/RS232 converter

USB port of computer is connected to USB front port
of the IED

USB port of computer is connected to a network of

IEDs connected via RS485 interface
Using the USB/RS485 converter

Computer is connected via Ethernet to
Ethernet/RS485 converter to which the IED network

is connected
Ethernet/RS485 converter in Real COM mode

IED network is connected to a modem set to auto
answer. The computer establishes a dial-up
connection

Computer is connected via Ethernet to
Ethernet/RS485 converter to which the IED network

is connected
Ethernet/RS485 converter in TCP Server mode

Computer is connected via Ethernet to each

BE2704/ED7 and BE2502/ED5 IED
Except for BE2704/ED7 V750 and V751 IEDs

Computer is connected via Ethernet to each
BE2704/ED7 V750 and V751 IED

RS232

Communication type

RS232

Select the COM port for connection

RS232
You should select the virtual COM port that will appear in the
system after connecting the converter

RS232

USB driver for connecting to the USB port on the front panel of
the BE2704/ED7 and BE2502/ED5 IEDs must first be installed. You
should select the virtual COM port that will appear in the system
after connecting the IED

RS232
You should select the virtual COM port that will appear in the
system after connecting the converter

RS232
You should select a virtual COM port that will appear in the
system after setting the converter

Modem connection
Modem used on the computer side must first be installed in the
operating system

Network connection

In the list of network connections, a connection of the TCP client
type must be added and the IP address of the converter and the
port number must be specified (Local TCP Port in the converter
settings)

Network connection

In the list of network connections for each IED, a connection of
the TCP client type must be added and the IP address of the IED
must be specified (the port number is fixed — 1001)

Network connection

In the list of network connections for each IED, a connection of
the UDP type must be added and the IP address of the IED must
be indicated (the port number is fixed — 1001)

When choosing the RS232 communication type, you should select the physical or virtual
COM port that will be used for communication with IEDs. The Properties button opens the
settings window for the selected port. The port rate must match the rate that all IEDs in the
network are set to, and the rest of the port parameters are fixed: 7 data bits, parity bit, 2 stop
bits (7-E-2). Flow control is disabled.

The Communication server updates the list of available COM ports on loading and when
the Main menu - Setting command is executed. If the desired port is not in the list of available
ports, close the Setting window, connect the IED or converter, and open the Setting window
again. If the port still does not appear, launch the Windows Control Panel, open the Device
Manager application and check the list and state of ports in the Ports (COM and LPT) element.

18



When the Communication server is started for the first time, an attempt is made to
initialize the COM1 port. When the message “Error initializing the serial port. The selected port
may be in use by another application”, you should set the Communication type and, if using RS232,
select the desired serial port.

MODEM CONNECTION

When selecting the connection type modem connection, select the modem that will be
used to communicate with IEDs. The Properties button opens a standard Windows modem
settings window. It is mandatory to set the modem connection parameters: 7 data bits, parity bit
and 2 stop bits (7-E-2).

If the list of modems installed on the computer is empty, launch Windows Control Panel,
open Modems application and add a modem, then restart the Communication Server.

NETWORK CONNECTION

When selecting the connection type network connection, by clicking the Properties button,
a list of connections should be generated.

If a network connection is used to connect to an Ethernet/RS485 converter, then to set
the connection parameters, use the Add and Edit commands in the All connections section.

For each connection, set the following:

— connection type (TCP client, TCP server or UDP);
— remote host (IP address or name and port);
— local port.

The selection of the connection type depends on which protocol is used (TCP or UDP) and
how the remote host is configured. If the remote host is in TCP server mode, TCP client mode
must be selected in the Communication server and the remote host address must be specified. It
is not obligatory to set a fixed number of the local port. Immediately after the Communication
server is loaded (and after leaving the setting mode), an attempt to establish connection with the
remote host is made for each network connection in the TCP client mode.

If the remote host is in the TCP client mode, then the TCP server mode must be selected in
the Communication server and a fixed local port number must be specified. In the TCP server
mode the remote host address is not specified.

While setting a UDP protocol, as a rule, IP address and the second end port number are
specified for each side. As a result, when configuring the Communication server, specify a fixed
local port number and afterwards specify this port number (and IP address of Communication
server) during remote host setup.

If a network connection is used to connect directly to BE2704/ED7 and BE2502/ED5
IEDs, then you should use the Add and Find commands from To devices section.

By executing the Add command, a new connection appears, for which you need to select
the connection type - UDP for BE2704/ED7 V750 and V751 IEDs and TCP client for all other
BE2704/ED7 and BE2502/ED5 IEDs that have LAN ports. Also, for a new connection, you need
to specify the IP address of the IED.

The Find command automatically searches for BE2704/ED7 and BE2502/ED5 IEDs
within the subnet. Found IEDs are added to the list of connections, with their IP addresses
highlighted in bold.

Each connection has an indicator to use the connection in the actual configuration.

IMPORTANT! IEDs do not allow simultaneous establishment of several TCP connections for
communication using the internal protocol. Therefore, when configuring network connections in
Communication servers, you need to make sure that the IP address of each IED is specified in only one
Communication server.
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4.1.4 LIST OF CONNECTED IEDS

The list of IEDs connected to the Communication Server is controlled using the Main menu
- Devices command.

For each IED, you must specify the address, factory number, type, software version,
location and the name of the station on which the IED is installed. Additionally, you can specify
the name of the IED, which will be used to identify this IED in all applications of the software
package.

The factory number of the IED is an integer in the range from 1 to 65,535. The number is
assigned to the [ED during manufacture and is indicated on the rear panel of the IED.

The IED address is an integer in the range from 1 to 899 when using the internal
communication protocol. All IEDs connected to one Communication server must have unique
addresses.

Using the Add button, you can connect the IED to the Communication server. At the same
time, a window of parameters of the connected IED appears on the screen.

To manage the list of stations, click the button with three dots to the right of the Station
input field. The name is specified for each station. In case of a modem connection with IEDs, a
phone number must be additionally specified for each station. If necessary, you can open a
window that allows you to change the dialing settings.

The Read parameters command allows you to read the factory number, firmware type
and version, IED name and location if there is a connection with IEDs.

The Write to device command allows you to write the name values entered in the window
(IED name, location, name of the station) to the IED (only for BE2704/ED7 and BE2502/ED5
series IEDs). The need to write names to the IEDs is due to two reasons: firstly, these names are
placed in the title of each oscillogram and, when the oscillogram is opened in the Waves
application, they are displayed on the panel with the main properties of the oscillogram, and
secondly, it is easier to reconfigure the Communication server, which may be required, for
example, when moving a server to a new computer.

If you want to re-read all the data written to the internal event recorders of an IED, you need to select
this IED in the Devices window. Then, using the right mouse button, open the context menu and
execute the Reread all events at the next interrogation command.

4.1.5 AUTOMATIC SEARCH FOR IEDsS

The list of IEDs connected to the Communication server can be created automatically. To
do this, open the IED list window and click the Scan button. The IED scan window will appear.
First, press the Properties button and specify scanning parameters:

— station (in case of a modem connection with IEDs, before the start of scanning, an
attempt is made to establish a connection with the selected station);

— initial and final address;
— number of attempts while addressing each IED;
— response timeout from [EDs (in milliseconds);

— add to existing device list (when this box is not checked, the actual list of IEDs is cleared
before scanning);

— request device name (when the box is checked, the location and name are read directly
from the IED, and when it is not checked, after scanning for each IED, open the Device window
and specify the location and IED name manually).

For BE2704/ED7 and BE2502/ED5 series IEDs that have the ability and need to read the
configuration file from the IED, the Read configuration box will be automatically checked.
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After writing new user settings to the IED or after configuring the switches, you must force the IED
configuration file to be updated. To do this, find the IED in the scan window and check the Read
configuration box.

4.1.6 DIFFERENT CONFIGURATIONS OF COMMUNICATION SERVER

The Communication server that starts without command line parameters has
configuration 1. To start the Communication Server with configuration 2, you need to create a
new shortcut to start the server, open the context menu of the shortcut, and execute the
Properties command. In the Target field, add the /config2 command line parameter:

“C:\Program Files(x86)\EKRA\EKRASMS\esServer.exe” /config2

For the Communication server with configuration 3, the /config3 parameter is used, and
so on. In total, up to 99 different configurations of the Communication server are supported.

Communication Servers with different configurations can work simultaneously.

Typical cases when you should use different configurations of the Communication server:

— Several IED networks are connected to several COM (or USB) ports of the computer,
united via the RS485 interface. You should configure the Communication server according to the
number of connected networks, each configuration will select its own physical or virtual COM
port;

— The computer is connected via Ethernet to Ethernet/RS485 converters or directly to
the IEDs. If the total number of IEDs exceeds 30, it is recommended to divide the IEDs into
several Communication servers so that each Communication server has no more than 30 IEDs.
This is especially crucial when using the Data Archiving Server for interrogating events and the
Oscillogram Server for automatically reading oscillograms, since all IEDs connected to one
Communication server are interrogated sequentially;

— The computer is connected via Ethernet to Ethernet/RS485 converters at different
stations. If the total number of IEDs is small, then you can connect them to one Communication
server. But then a temporary loss of communication with the IEDs of one station (for example, in
case of some problems with the network) will lead to a slowdown in the exchange with IEDs at
other stations. And if you set up your own configuration of the Communication server for each
station, then the loss of connection with one station will not affect the rate of exchange with
other IEDs.

If there are 50 or more IEDs in the list of devices of one Communication server, then when the Devices
window is closed, a warning will be displayed that when using the Data Archiving Server or the
Oscillogram Server, it is not recommended to connect such a number of devices to one Communication
server.

4.1.7 COMMUNICATION SERVER SETTINGS

By command Main menu - Setting, the settings window of the Communication server
appears.

COMMUNICATION SETTINGS

Response timeout. The time during which the Communication Server waits for a response
from the device. The default value is standard. With an RS232 connection, the latency is 100 ms
plus the transport time, with a modem connection it is 600 ms plus the transport time, with a
network connection it is 300 ms plus the transport time.

When using GSM modems in the modem connection mode, as well as in some cases with
a network connection, the standard response time is not enough. The value should be set to
increased. In this case, the response time will be more than 2,000 ms.
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It is possible to organize very slow communication channels with IEDs, when even
increased time is not enough for waiting for a response. In such cases, the value should be set to
the maximum. In this case, the response time will be more than 1 minute.

Software support for 7-E port parameters. Not all modems are capable of working with 7-
E-2 port settings. In particular, this applies to some GSM modems. To use such modems, check
the Software support of 7-E port parameters box. Connection parameters of such modems should
be: 8 data bits, parity bit is not checked and 2 stop bits (8-N-2).

Pause between receiving and transmitting. Some RS232/RS485 or USB/RS485 converters
require a short pause to switch from transmit mode to receive mode for correct operation. In
such cases, you should set the value of the Pause between receiving and transmitting parameter
(default - 0 ms, maximum value - 50 ms).

TCP/IP

TCP port number for Monitoring program. The same port is used to connect the Oscillgram
Server, OPC Server, Duty Operator AWS and IEC 60870-5-103 Gateway. The default value is 1389
for the first configuration, 1391 for the second, 1393 for the third, and so on.

TCP port number for Data Archiving Server. The default value is 1390 for the first
configuration, 1392 for the second, 1394 for the third, and so on.

SYNCHRONIZATION

Time synchronization in devices. Whether or not to synchronize the time of all connected
IEDs according to the clock of the EKRASMS server. In order for synchronization to take place,
the Time synchronization parameter must be correctly specified in IEDs. IEDs connected directly
via Ethernet are synchronized using the SNTP protocol.

Date synchronization period. Interval between commands for date synchronization. When
synchronizing the date, a full time stamp is sent to the information network of IEDs - year,
month, day, hours, minutes, seconds, milliseconds. The recommended value is 60 seconds.

Time synchronization period. Interval between commands for time synchronization. Time
synchronization commands contain only seconds and milliseconds. With a modem connection,
only the date synchronization commands are executed. The recommended value is 10 seconds.

EVENT INTERROGATION

Response timeout. Time to wait for a response from IEDs when reading events. The
recommended value is 100 ms.

Interrogation frequency without data. The interval between commands for event
interrogation in cases when there are no new events in the IED. The recommended value is
1,000 ms.

START

Run on logon. If you check this box, then the actual configuration of the Communication
Server will be automatically started when the actual user logs in.

Deny restart of this configuration. If the box is checked, the second start of the
Communication Server with this configuration will be blocked.

DESCRIPTION

Server description. The text that will appear when hovering over the Communication
Server icon on the Windows taskbar. It makes sense to use this setting if different configurations
of the Communication Server are used to connect to different stations.
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4.2 DATA ARCHIVING SERVER

4.2.1 FUNCTION

The Data archiving server automatically connects to all local Communication servers (that
is, those running on the same computer), collects events from IEDs connected to these
Communication servers, and transfers them to the database by connecting to the Archive service.

If you are connecting to a Communication server, the type of connection with IEDs of
which is a modem connection, then when connecting, you will need to select the station with
which the modem connection will be established.

Just like the Communication server, the Data archiving server runs in the background, and
its operation is indicated by the icon on the Windows taskbar. The same icon also serves to open
the main menu.

During the collection of events, the main menu item Event interrogation will be checked.
If for some reason you need to stop collecting events forcibly, you need to uncheck the Event
interrogation box.

4.2.2 SETTING

In order to switch the Data archiving server to setting mode, stop interrogating events. By
executing command Main menu - Settings, the Data archiving server settings window appears.

EVENTS

Database server. Select either local or remote database server. To connect to a remote
database server, you must either find this server if it is within the subnet, or specify its address
manually. Also, to connect to a remote server, you need to specify a username and password.

Run on logon. If you check this box, the Data archiving server will automatically start
when the actual user logs in.

Place measurements in database. If the box is checked, during the interrogation of events,
the [EDs will additionally be requested and the results of recorded measurements will be placed
in the database.

Place reports on changes in settings in database. When changing and writing IED settings
through the Monitoring program, a text file is generated, in which it is recorded which EKRASMS
user, from which computer, when and which settings he changed. When the box is checked,
these files with reports will be added to the database.

Rebroadcast events. This box must be checked when using an Workspace, OPC Server, or
IEC 60870-5-103 Gateway. These applications connect to the Data archiving server via the
specified TCP port. The default value is 1388.

NOTIFICATIONS

On the Notifications page, you can check boxes for sending system messages about the
following events:

— device restart/turning off;

— loss of connection/reconnection with device;
— device failures;

— signaling;

— change of settings;

— control of settings;

— oscillatory binary inputs;

23



EKRASMS

— frequently changing state internal signals.

If the Control of settings box is checked, then in the event interrogation mode, a periodic
request is made for the actual values of settings of those IEDs for which standard images will be
found. The actual setting values are compared with the setting values in the standard image. The
setting values in all groups and the values of all IED parameters are compared, except for the
position of operational switches.

When changes are detected, a system notification is generated with the following
information: series and factory number of the IED, date and time when the standard image was
recorded, full user name and organization, date and time when the actual settings were received,
and the number of differences found.

Reports on settings control can be sent by e-mail. To do this, check the Control of settings
box in the Perform mailing section and use the Mailing list command to generate a list of mailing
addresses.

4.2.3 STATE DIAGNOSTICS

By executing command Main menu - Diagnostics - Server status, the Status window
appears.

If the Data Archiving Server is configured to connect to a local database server and the
“Inactive service” message appears in the upper part of the Status window, open the Arsenal
application (see paragraph 2) and enable the Archive service.

COMMUNICATION SERVERS

The Communication Servers page displays a list of all Communication Servers
configurations found on the local computer and the state of connection to each of them. If text
“Error 10061. Impossible to establish connection with communication server” appears in the Error
column, then most likely this configuration of the Communication Server is not started.

DEVICES

The Devices page displays a list of all [EDs that are connected to Communication Servers
with which there is a connection. For each IED, the event receiving state is displayed. The
“reading events” state means that the IED is currently reading the previously recorded events.
The “events read, interrogation is in process” state means that all previously recorded events
have been read and interrogating is currently being performed to receive new events.

If there is a need to connect to a specific IED, read all registered events from it, and then save these
events, you should configure the connection to the IED in the Communication Server, scan devices, and
add this IED to the device list. Next, close all configuration windows in the Communication Server and
load the Data Archiving Server. 5 seconds after loading, interrogation of events starts automatically. In
the Data Archiving Server in the Status window, you need to find this IED. As soon as the “events read,
interrogation is in process” state appears, you can connect to the database in the Timeline application
and save the events.

4.3 OSCILLOGRAM SERVER

4.3.1 FUNCTION

The Oscillogram server is designed to automatically collect oscillograms from IEDs in
accordance with the settings and the specified schedule.
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Just like the Communication server, the Oscillogram Server runs in the background, and its
operation is indicated by the icon on the Windows taskbar. The same icon also serves to open the
main menu.

The Oscillogram server operates in the following way:

— at the first start, the process of synchronization of oscillograms available on the
computer and the oscillograms in the IEDs begins, during which all oscillograms with an
acceptable age that are absent on the computer will be read from IEDs. At the end of
synchronization, the Oscillogram server records the actual numbers of starts and begins
operating according to the schedule;

— when new oscillogram appear, synchronization is performed again, as a result of which
reading of new oscillograms is performed. The user can turn off the interrogation for a long time;
it will not lead to data loss, since synchronization will be carried out immediately after the
interrogation is resumed.

Establishing a connection with Communication servers and switching to the IED
interrogation mode can be done either when the Oscillogram server is started, or forcedly using
the Main Menu - Oscillogram Interrogation command.

When the Oscillogram server is switched to the setting mode, interrogation of
oscillograms is paused.

4.3.2 SETTING

To configure the Oscillogram server, execute the Main Menu - Settings command.

COMMUNICATION SERVERS

The Oscillogram server connects to one or more Communication servers and receives
oscillograms from IEDs connected to these servers. The selection of Communication servers and
IEDs is carried out on the Main menu - Setting - Communication servers page.

By means of commands on this page, you can form a list of Communication servers: add
them manually, search for Communication servers in operation in the local network, delete or
change parameters of connected Communication servers.

SCHEDULE

The Oscillogram server collects oscillograms automatically. This means that oscillograms
will be received from IEDs as soon as they appear and are detected by the Oscillogram server. In
order to track the fact of appearance of new oscillograms, the Oscillogram server periodically
interrogates IEDs. The interrogation mode and parameters are specified by the user and are
called the schedule. The Oscillogram server can serve several facilities at the same time and each
can have its own schedule. To configure the schedule parameters, open the Main menu - Setting
- Schedule page.

Select a station in the station structure and click the Change the schedule for the station
button. The station schedule setting wizard window will open, which is a sequence of pages for
selecting the mode and time for interrogating IEDs.

The first step is selection of interrogation modes:

—once after the start of interrogation (in this mode, IEDs will be accessed once
immediately upon manual start of interrogation (using the Main menu - Oscillogram
interrogation command) or upon automatic start (when the Oscillogram server is started));

— periodically (in this mode, periodic interrogation is performed with a specified time
interval);

— every day (in this mode interrogation is performed at predefined times during the day);

— after receiving event Start recorder (in this mode, interrogation is performed 1 minute
after receiving the Start recorder event).

25



EKRASMS

The second step is selection of interrogation time (depends on the mode selected during
the first step):

— for once after the start of interrogation mode - interrogation time is determined by the
moment of its start;

— for periodically mode - the time interval between interrogations is specified in minutes;
— for every day mode - the list of time stamps is specified when interrogating;

— for after receiving event Start recorder mode - the time interval between backup
interrogations is specified. A backup interrogation will be performed when the Oscillogram
server is detected as not ready to receive the binary Start recorder event. This can happen due to
the absence of a signal in the registration mask, if there is no connection with the Data archiving
server, if the Data archiving server is not ready to receive and transmit the event to the
Oscillogram server.

The third step is to select the parameters of repeated interrogation. If at the time of
interrogation the Communication servers or IEDs are not fully ready, then the next interrogation
may not take place. In this case, it is possible to repeat the interrogation several times at a
specified time interval.

By default, the periodically interrogation mode is specified with an interval of 1 minute.

For each IED, you can define a priority level for transmitting oscillograms. A higher
priority gives the IED the right to transmit oscillograms in the first place. This is useful when, as
a result of an accident, several IEDs record oscillograms at once (including IEDs serving
neighboring bays), but the user would first of all want to receive oscillograms of IEDs that
tripped. The criterion can be the presence of a Tripping alarm. In this situation, the Oscillogram
server queues the IEDs based on their priority.

To change the priority, select the IED in the station structure and press Change the
priority of the device button:

For the highest priority level, select a binary signal that will become the priority criterion,
e.g. Tripping. It is also necessary to select the Data archiving server through which the
emergency event will be received. If, as a result of an accident, the IED recorded an oscillogram,
but there was no Tripping signal (or it was not received due to the Data archiving server being
unavailable or not in the registration mask), then the IED will receive a normal priority level.

PARAMETERS

On the Main menu - Setting - Parameters page, you can enable the option to save
oscillograms in COMTRADE format. The format standard, file type, analog value type and
encoding are specified. When box perform substitution in accordance with requirements for signal
names is checked, the original file names and channel identifiers are replaced in accordance with
the requirements of a number of standards (see paragraph 5.10). When box merge frames into
one file is checked, those oscillograms that are divided into frames of 64 KB in the original
format are combined into one file in the COMTRADE format.

Reading outdated oscillograms. Determines the age of oscillograms, after which the
oscillogram files are considered outdated and will not be read from IEDs.

Enable notifications. Specifies whether to display notifications about reading
oscillograms.

Enable mailing. Specifies whether read oscillograms should be sent via e-mail. By
command Mailing addresses, you should create a list of mailing addresses.

OSCILLOGRAM FOLDERS

On the Main menu - Settings - Oscillogram folders page folders are specified where the
oscillograms received from IEDs will be placed. The folders for original format oscillograms and
COMTRADE format oscillograms may be different. Here you can also set the rules by which the
Oscillogram server will automatically generate the folder structure.
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PLACEMENT OF OSCILLOGRAMS IN EKRASMS DATABASE

In addition to collecting oscillograms in a designated directory, the Oscillogram server
also places them in EKRASMS database.

I To access the database (Archive service), the settings of Data archiving server are used

START MODE

On the Main Menu - Settings - Start mode page, you can enable the Oscillogram server to
start automatically when you log in to Windows, as well as enable automatic start of oscillogram
interrogation according to the schedule immediately after starting the Oscillogram server.

SETTINGS FILES

On Main menu - Settings - Settings files page you can enable reading settings files of the
BE2704/ED7 and BE2502/ED5 IEDs in the internal sfr format and save them to disk according
to the specified schedule. You need to specify the folder where the settings files will be placed.
New settings files appear only after a change in the values of any settings has been detected.

When box save settings as XML file is checked, in addition to the settings file in sfr format,
settings will be saved in the format intended for transferring setting values to third-party
software (see paragraph 11).

DESCRIPTION

Description of oscillogram server. The text that will appear when hovering over the
Oscillogram server icon on the Windows taskbar. This setting makes sense if you use different
Oscillogram server configurations to connect to different facilities.

Different configurations of the Oscillogram server, if necessary, are created in the same way as
different configurations of the Communication server (see paragraph 4.1.6).

4.4 OPC SERVER

4.4.1 FUNCTION

OPC Server is designed to integrate IEDs available in EKRASMS into PCS according to the
OPC standard.

The application is described in more detail in document 3KPA.00002-01 90 03 “OPC
Cepgep”.

4.5 IEC60870-5-103 GATEWAY

4.5.1 FUNCTION

The IEC 60870-5-103 Gateway is designed to integrate IEDs available in EKRASMS into
PCS according to the IEC 60870-5-103 standard.

The application is described in more detail in document 3KPA.00002-01 90 02 “lllnt03
60870-5-103".
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5 MONITORING PROGRAM

5.1 FUNCTION

The Monitoring program is designed to configure and monitor IEDs available in
EKRASMS.

5.2 STATION STRUCTURE

The station structure is a list of IEDs available at stations and a list of Communication
Servers that provide access to these IEDs. The station structure is stored in a text file called a
station structure description file.

When you first start the Monitoring program, a message will appear stating that the
station structure description file was not found. To create a station structure, execute the Station
- Create station structure command.

The list of communication servers initially contains only the local communication server,
which should be used if the Monitoring program and the only Communication Server are running
on the same computer. You can add other configurations of Communication Servers or
Communication Servers running on other computers to the list. To do this, in the Communication
Servers group, click the Add button. For each Communication Server, you must specify its name,
which is used only by the Monitoring program and can be arbitrary.

The Find button in the Communication Servers section allows you to automatically search
for all operating Communication Servers within the primary domain of the local network. After
the search for Communication Servers, the search for devices connected to these servers will be
performed automatically.

If the list of Communication Servers is generated, then to search for devices connected to
them, click the Find button in the Devices section.

If the station structure has been successfully created, then upon completion of the
Monitoring program, you will be prompted to save the station structure as a file. By default, it is
proposed to save the structure to the Station.stt file in the station description files folder.

You can generate multiple station structure files and load the required ones as needed.
The last used station structure file is applied automatically when the Monitoring program is
loaded.

The station structure is displayed as a tree in the Monitoring Program window in the left
part. IEDs are grouped by stations and locations. By default, separate elements for sttations are
not created in the tree. For each IED, Actual values, Adjustable parameters, Fault oscillograms,
Fault signaling elements are created.

If the structure contains IEDs located at different stations, you can execute the View — Properties
command and on the General page check the box to create elements with station names in tree. In the
same place, you can check the box to sort station structure elements — then in the tree the elements at
the level of stations, locations and devices will be sorted alphabetically.

The right part of the Monitoring program window displays the contents of the selected
station tree element.
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5.3 ESTABLISHING CONNECTION AND ACQUIRING DATA

If the Communication - Establish connection automatically menu item is checked, then the
connection with the corresponding Communication Server will be established automatically
when an IED is selected in the station tree, otherwise, to establish a connection, execute the
Communication - Establish connection with actual server command. The Actual server is the
Communication Server to which the IED selected in the station tree is connected. If the attempt to
establish a connection fails, an error message and corresponding recommendations will appear
on the screen.

Once the connection is established, you will be prompted for a username and password,
which are specified in the Arsenal application. Access to internal databases of IEDs can be
obtained only after successful login to the Communication Server.

When navigating through the station tree, the data corresponding to the selected element
in the station tree will be automatically requested.

You can force an update of the data in the currently selected tree element using the
Device - Update information (F5) command. The data acquisition process can be interrupted at
any time using the Device - Stop (Esc) command.

5.4 ADJUSTABLE PARAMETERS, EDITING SETTINGS

When navigating through the station tree, only the values of those parameters that are
included in the node selected in the station tree are requested. Using the Parameters - Read
actual parameters (F3) command you can read the values of all adjustable parameters of the
actual device. By default, the automatic reading of parameters mode is enabled - when you enter
the Adjustable parameters node of any device for the first time, all adjustable parameters of this
device will be read.

In order to change the value of any parameter, just double-click the left mouse button on
the parameter name. If you need to change the values of several parameters, select the required
parameters with the mouse or keyboard keys and press the Enter key or execute command
Parameters - Edit parameters - Edit selected parameters.

If the values of any adjustable parameters are changed, then the Parameters - Write
edited parameters (FZ2) command will become available. When writing parameters, a password
for remote access to device will be requested. The password for remote access to the IED is
requested in the following cases:

— when editing settings;

— during remote alarm reset;

— during remote oscillogram memory reset;
— when saving the image.

The password for remote access to the IED can be changed using the Device - Change
device password command, possible password values are from 1 to 9999. By default, the
password for remote access to the IED is as follows:

—“1” for IEDs of BE2704/ED7 and BE2502/ED5 series;
—“2716” for IEDs of the BE2702(M) series.

The password for remote access to the IED should not be confused with the password for writing the
settings, which is requested when editing the settings using the buttons on the front panel of the IED.

Some settings of BE2704/ED7 and BE2502/ED5 IEDs (for example, settings 9-2) are
written in a special way. When changing the values of such parameters, they must be written to
the IED using the Parameters - Write edited adjustment parameters command.
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For IEDs of BE2702(M) series, you can change the parameters of analog inputs (numbers
of input sensors, primary and secondary values) in accordance with the W(Config. NNN
configuration file. To do this, execute command Parameters - Edit parameters - Edit by
configuration file.

In order to edit the settings, the user must have the appropriate access right to the Communication
Server enabled.

5.5 IED IMAGE

To save all IED settings in a file, execute the Parameters - Save image command. The
image file will include a configuration file, a copy of the IED's actual settings, and user settings
(table of names and programmable logic of the IED). The IED image can be used to service the
IED in the Mix application, the image can be opened by Atlas settings analysis application to view
and compare settings, and the image can be used to restore the IED parameters in the Monitor
program.

Please note that the saved image will not include the IED firmware. To get a backup copy of the IED,
i.e. full image along with the firmware, put the IED into service mode and use Mix application.

The Parameters - Fix standard image command allows you to save the image with
additional information about the user who performed the operation. Standard images are used
by the Data Archiving Server to automatically control settings.

The Parameters - Save setting parameters command allows you to save only the IED
setting parameters in a file with the ADJ extension.

Commands Parameters - Restore parameters from file are intended for restoring
previously saved parameters. You can restore parameters from MIX IED image files, from DFR
oscillogram files, from SFR settings files, as well as from files with ALL, ADJ, PR, OSC extensions
saved by previous versions of the Monitoring program. To write the restored values to the IED,
execute the Write edited parameters command.

After specifying the settings and parameters of the IED, it is recommended to save the
[ED image.

If you need to edit the user settings of the IED, you should save the image of the IED, open
this image in the Mix application, make the necessary changes, save the image in the Mix
application, and, finally, in the Monitoring program, execute the Parameters - User settings -
Write command.

5.6 SETTING GROUPS

Some types of IEDs of BE2704/ED7 and BE2502/ED5 series have versions with several
groups of settings. Commands Parameters - Setting groups are designed to work with adjustable
parameters that have versions in different groups.

The Select setting groups command allows you to specify the groups that will be
displayed on the screen. You can select only the working setting group, you can select all setting
groups, or you can explicitly specify which setting groups you want to display.

The Transfer protection parameters command allows you to copy protection settings
from one group to another.
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5.7 ACTUAL VALUES AND VECTOR DIAGRAMS

The mode of reading actual values is specified on Actual values page of the parameter
setting window of the Monitoring program. In the cyclic reading mode, the actual values included
in the selected group are reread with the period specified in the settings. In read-once mode,
values are requested once and updated with the Update information command.

Commands Actual values - Display actual values - in primary values (in secondary values)
allow you to display the values of analog signals either in primary or secondary values. For some
versions of IEDs commands in primary values (in secondary values) are replaced by commands in
absolute values (in relative values).

The Actual values - Vector diagram command allows you to draw vectors of the first
harmonic of selected currents and voltages of the actual IED. The drawing is made relative to the
base vector of the IED. The appearance of a window with a vector diagram does not block the
execution of other application functions. Simultaneous display of multiple vector diagrams from
different IEDs is possible.

5.8 OSCILLOGRAMS

If the connection to the Communication Server is established, and the Fault oscillograms
element is selected in the station tree, then the IED directory will be read and a list of
oscillograms written by the IED will appear. Oscillograms can then be saved as DFR files or
deleted.

When the Oscillograms - Copy... command is executed, the selected oscillograms will be
copied to the specified folder. When the Copy command is executed, the selected oscillograms
will be copied to the previously selected folder. Folder naming options allow you to organize
oscillograms by stations, locations, IEDs, and dates.

The copied oscillograms in the list will be marked with a flag. The Copy missing command
allows you to select all unread oscillograms and start copying them.

If you double-click the oscillogram name with the left mouse button (or press the Enter
key), then, depending on whether this oscillogram is on the computer or not, the Waves
application (if it is installed in the system) will be opened or the oscillogram copying will begin.
If settings files are shown in the list of files along with oscillograms, then selecting the settings
file and executing the Open command will open the Atlas application.

To delete selected oscillograms from the memory of the IED, execute the Delete
command.

In IEDs BE2704/ED7 and BE2502/ED5 of the latest generation, it is not possible to delete individual
oscillograms from the IED memory. Only complete clearing of the oscillogram memory is available if
the user has the appropriate access rights to the Communication Server.

You can sort the list of oscillograms by name, size or date, for which just left click on the
title of the corresponding column or execute the Oscillograms - Sort command.

Apart from commands to copy, delete and sort oscillograms, Oscillograms menu includes
a number of commands for oscilloscope operation:

— Start oscilloscope (by this command, the oscilloscope starts for the time specified by the
setting of the oscilloscope for the duration of the post-fault recording);

— Format CompactFlash (for IEDs of the BE2704/ED7 series, in which oscillograms are
recorded on a CompactFlash memory card, this command is used to format the memory card;
the command is executed by password);

— Clear oscillogram memory (for IEDs in which oscillograms are written in electronic
memory, this command resets the electronic oscillogram memory; the command is executed by
password);
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— Format floppy disk (for IEDs of BE2702(M) series this command is used to format a
floppy disk; the command is executed by password).

While copying or deleting oscillograms, a message may appear indicating that file
operations are being performed by another user. This is due to the fact that simultaneous access
of several users to the directory or files of one IED is not possible. In this case, you should try to
perform the required operation again later.

5.9 OSCILLOGRAMS IN COMTRADE FORMAT

5.9.1 SELECTING STANDARD

IEDs of BE2704/ED7 and BE2502/ED5 series save fault oscillograms in the internal
format, as files with the DFR extension. But when reading oscillograms, the files can be
converted to COMTRADE format. This happens in the following cases:

— when reading oscillograms using the MMS protocol in accordance with the IEC 61850-
8-1 standard;

—when automatically reading oscillograms using the Oscillogram Server, if the
corresponding option is enabled in the settings.

When generating oscillograms in COMTRADE format, file names and channel identifiers
can be brought into line with the following standards:

—STO 56947007-29.120.70.241-2017 company standard, amended on 11.12.2019
(“Technical requirements for microprocessor relay protection devices”);

— GOST R 58601-2019 (“Relay protection and automation. Autonomous emergency
event recorders. Standards and requirements”);

—STO 59012820.29.020.009-2016 company standard (“Relay protection and
automation. Automated collection, storage and transmission to control centers of SO UES JSC of
information about emergency events from electric power facilities equipped with digital devices
for recording emergency events. Standards and requirements”);

—STO 59012820.29.020.006-2015 company standard (“Relay protection and
automation. Autonomous emergency event recorders. Standards and requirements”).

To select a standard, use command Oscillograms - Specify names in COMTRADE files.

5.9.2 STO 56947007-29.120.70.241-2017

When selecting STO 56947007-29.120.70.241-2017 company standard you must
specify the following parameters in accordance with the requirements of the standard:

— company code (you should select a numeric and alphabetic code);
— supervisory object name;

— short supervisory bay name;

— voltage class;

— RPA panel number;

— short functional name of the device.

The Generate channel parameters command automatically generates the ch_id (channel
identifier) and cchm (circuit component) fields for all analog and binary channels.
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5.9.3 GOST R 58601-2019

When selecting the GOST R 58601-2019 standard, you must specify the following
parameters:

— company name of the legal entity;
— supervisory object name;
— name of the autonomous fault recorder.

Identifiers and circuit components for analog and binary channels must be specified
manually.

5.9.4 STO 59012820.29.020.009-2016

When selecting STO 59012820.29.020.009-2016 company standard, you must specify
the following parameters:

— supervisory object name;
— name of the device.

Identifiers and circuit components for analog and binary channels must be specified
manually.

5.9.5 STO 59012820.29.020.006-2015

When selecting STO 59012820.29.020.006-2015 standard, you must specify the
following parameters:

— supervisory object name;
— name of the autonomous fault recorder.

Identifiers and circuit components for analog and binary channels must be specified
manually.

5.9.6 WRITING DATATO IED

By the Write command, data for COMTRADE files are written to the IED's memory. This
data will be used by the IED when generating COMTRADE files for transmission via MMS
protocol in accordance with the IEC 61850-8-1 standard.

The Read command allows you to read data for COMTRADE files from the IED's memory
for control or editing.

5.9.7 SAVING DATA AS FILE

The Save command saves data for COMTRADE files to a service file linked to the factory
number of the IED. This file will be used by the Oscillogram Server when generating COMTRADE
files.

The Restore command allows you to load data for COMTRADE files from a service file for
control or editing.
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5.10 FAULT SIGNALING

To get the actual state of alarm indicators, select the Fault signaling element in the station
tree.

Remote reset of the fault signaling is carried out by the Device - Reset signaling command.
Execution of this command requires entering a password for remote access to the IED and that
the user has the necessary access rights.

5.11 BINARY SIGNALS AND OUTPUT RELAYS

If the actual IED belongs to BE2704/ED7 or BE2502/ED5 series, then commands Binary
signals and Output relays will be available in the Parameters menu. When the Binary signals
command is executed, a table of binary signals will appear on the screen.

The table of binary signals allows you to select the signals that will be used to start the
oscilloscope and that will be recorded.

The Update and Write buttons allow you to synchronize the values in the table with the
values in the connected IED (they work similarly to the read and write commands for adjustable
parameters in the main window of the Monitoring program).

Masks of binary signals in Start recorder when switching from 0 to 1 and Start recorder when switching
from 1 to 0 are mutually exclusive. In the Recording mask for binary signals section, no more than 48 or
128 signals can be selected depending on the IED version.

The table provides a context menu that allows you to quickly enable or disable all values
in the selected column.

The Parameters — Output relays command displays a table similar to the table of binary
signals, designed for quick configuration of output relays, LEDs, and assignment of a binary
signal to the Control output.

5.12 BE2704/ED7 V900 CONFIGURATION

Creation of the configuration of inputs of BE2704/ED7 V900 type IED of versions 042
and 200, reading of the previously created configuration, as well as changing the configuration
and writing changes, are carried out by BE2704/ED7 V900 Configurator application.

For BE2704/ED7 V900 type IEDs versions 040 and 041, it is necessary to use the application Wizard for
setting recording BE2704/ED7 V900 type IEDs. For IEDs of BE2704/ED7 V900 type, versions 300 — 303,
the names of channels and circuits are specified in the Mix application by editing the name table.

5.12.1 CREATING NEW CONFIGURATION

A new configuration of IED inputs is created by the Monitoring program menu command
Parameters - 2704V900 Configuration - Create. At the same time, a new configuration is created
according to the table of sensor versions installed in the IED. This command starts the
Configurator with default parameters. Next, input circuits are configured, and after the work is
completed, the Configurator writes a new configuration to the IED.
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5.12.2 EDITING PREVIOUSLY CREATED CONFIGURATION

A previously created configuration can be retrieved from the IED using the Monitoring
program menu command Parameters - 2704V900 Configuration - Edit or loaded from a file with
the RCF extension using menu command Parameters - 2704V900 Configuration - Restore from
file. Next, input circuits are configured, and after the work is completed, the Configurator writes
a new configuration to the IED.

5.12.3 SETTING INPUT CIRCUITS

Input circuits are configured using a five-step wizard.

SETTING BINARY INPUTS OF IED

The first step is to specify the names of IED's binary inputs:
— full name (up to 28 characters) used for display in EKRASMS applications and services;

— short name (up to 11 characters) used for display on the IED and in oscillograms.

SETTING THREE-PHASE CIRCUITS

The contents of the Configurator window in the second step allow the user to configure
three-phase circuits of the IED. Depending on the version of the IED, up to five three-phase
circuits can be organized from analog inputs. Three-phase circuits make it possible to operate
with phase and line values, as well as symmetrical components.

You can create three-phase voltage and current circuits. For each three-phase circuit, the
following are specified:

— full name (up to 28 characters) used for display in EKRASMS applications and services;
— short name (up to 16 characters) used for display on the IED and in oscillograms;
— phases 4, B and ( that indicate analog inputs forming a three-phase circuit;

— transformation ratio of instrument transformers to which the analog inputs are
connected, forming this circuit.

SETTING ANALOG INPUTS

The setting of analog inputs that have not been assigned to any of the circuits is carried
out in the third step. In addition to analog inputs, which have not been grouped into three-phase
circuits, up to eight DC sensors can be installed in the IED, which cannot be used to form three-
phase circuits. For each input, the full name, short name, and transformation ratio are specified.

SETTING GROUPS OF THREE-PHASE STARTING ELEMENTS

For the first two three-phase circuits, the IED allows you to calculate phase-to-phase
values, symmetrical components, as well as their increments, which are considered as three-
phase starting elements. The set of three-phase starting elements, taken along one of the circuits,
constitutes a group of three-phase starting elements. Setting the parameters of groups of three-
phase starting elements is carried out at the fourth step.

For each group of three-phase starting elements, the following are specified:

— three-phase circuit that will be used to calculate the above starting parameters;

— blocking Uab,min from the current input, which is used to block the three-phase
starting element of the group by line voltage Uab,min in the event of a current failure at the
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selected current input. If the current circuit is selected as the three-phase circuit, this parameter
is not supported.

The information bar below the table shows the actual and possible number of groups of
three-phase starting elements. The possible number of groups of three-phase starting elements
is determined based on the number of organized three-phase circuits, and cannot be more than
two.

POWER SETTING

At the fifth step, the three-phase bay powers are configured. The IED allows you to
calculate the active and reactive power of three-phase bays. These values can be observed in
EKRASMS applications and services or on the [ED display.

The following is specified for each power:

— three-phase voltage circuit, which is described by the inputs connected to instrument
voltage transformers of the given bay;

— three-phase current circuit, which is described by the inputs connected to instrument
current transformers of the given bay.

The information bar below the table shows the actual and possible number of three-
phase powers. The possible number of capacities is determined based on the number of current
circuits and in the limiting case (12 current sensors with four voltage sensors) is 4.

The power names in the EKRASMS applications and services and on the IED display
correspond to the names of the corresponding current circuits.

5.13 SETTING

The Properties command on the View menu allows you to open the Monitoring program
setting window.

On the General page, you can set the parameters that control the time of receiving or
updating data, the type of data display in the station tree, and the generation of the device
configuration.

On the Actual values page, you can specify the reading mode and format for presenting
actual values.

On the Parameters page, the modes of reading, displaying, saving and reading adjustable
parameters are configured.

On the Oscillograms page, the modes of reading and displaying oscillograms are specified.
You can also set the root directory for saving oscillograms and specify the rules by which the
Monitoring program will generate the folder structure within the root directory.

5.14 COMMAND LINE PARAMETERS

Valid command line parameters when loading the Monitoring program:
— /station=<station structure description file>

— /device=<factory number of the device selected when loading>

- /username=<user name>

— /password=<user password>

— /interface=<program interface version number>

_/’)
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The /device parameter requires the /station parameter. The /username parameter
requires the /station and /device parameters. The /password parameter requires the /station,
/device, and /username parameters.

If the command line parameter contains spaces, then such parameter must be enclosed in double
quotes.

Example:
“C:\ProgramFiles(x86)\ EKRA\EKRASMS\esClient.exe” “/station=C:\My Data\Station.stt”

5.15 ERROR MESSAGES

5.15.1 ESTABLISHING CONNECTION WITH COMMUNICATION SERVER

When establishing a connection with the Communication Server, an error situation may
occur for several reasons:

— messages may appear: “Computer with IP address of communication server specified in
station structure description file not found”, “Route to communication server not found”, “Failed to
determine IP address of communication server by specified computer name”, “Communication
server by specified address not available”. In this case, you should make sure that the computer
with which you want to establish a connection is working and check that the name or IP address

of this computer is specified correctly.

— it may turn out that a computer was found at the specified name or IP address, but the
Communication Server on this computer is not started or uses a TCP port that is not specified in
the Monitoring program.

5.15.2 ABSENCE OF CONFIGURATION FILES

When loading the station structure, only those IEDs of BE2704/ED7 and BE2502/ED5
series will be included in the tree, for which the correct configuration files will be found in the
configuration files folder. If any configuration files are not found, an error message will appear.
In this case, you should scan the IEDs connected to Communication Servers and, if necessary,
read the missing configuration files. Next, in the Monitoring program, execute the Station - Edit
station structure command and click the Find button in the Devices section.

5.15.3 ABSENCE OF ACCESS RIGHTS TO INFORMATION

The name under which the user connected to the Communication Server determines
which operations will be available in the actual session. Before any operation is performed, it is
checked whether the operation is allowed. If execution is not allowed, a corresponding message
will appear on the screen.

5.15.4 ACCESS TO INTERNAL DATABASES OF IEDS

When accessing the IED, message “Timed out waiting for response from device” may
appear, which means that the IED does not respond to requests via the communication channel.
An interruption in communication over the communication channel may be temporary and may
be caused, for example, by a change in adjustable parameters or by starting the oscilloscope. It is
recommended that you perform the desired operation again after a few seconds. If
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communication with the IED is not restored, then you should make sure that the IED is
operating, check the [ED address and the speed of the communication channel.

Message “Timed out waiting for response from communication server” may be caused by a
failure of the computer on which the Communication Server is running, or by a failure of the
Communication Server itself. If this message appears, you should repeat the interrupted
operation, break and establish a connection with the Communication Server, make sure that the
Communication Server is running.

When reading or writing adjustable parameters, when working with oscillograms,
messages “Parameters read by user XXXX”, “Parameters written by user XXXX”, “File operations
performed by user XXXX” may appear. These messages appear because several users cannot
perform certain operations at the same time. In this case, perform the required operation later.

38



6 TIMELINE. EVENT ANALYSIS

6.1 FUNCTION

The Timeline application is designed to analyze events collected by means of ERKASMS
into a database. It allows you to open a selection from the data source in the form of a table, and
provides a number of tools for its analysis.

The data source can be:

— Database (via the Archive service), both locally and remotely;

— File with events.

6.2 RECEIVING OF EVENTS SELECTION

6.2.1 RECEIVING OF EVENTS FROM DATABASE

In order to make events selection from the EKRASMS database, you must execute the
Connect to database command from the main menu. You will need to specify the address of the
database server and enter the parameters for logging into the server. Next, a connection will be
made to the Archive service on the specified server and general information about the database
will be received.

To connect to the Archive service, you must specify a username and password. The user must be
registered with Arsenal on the target server (even if the connection is made locally) and be a member
of a group that has the Read events right in the Archive section.

The screen will show paginated elements for limiting the amount of data to select:
— Calendar - entering of time limits;
— Types - selection of only event types of interest;

— Devices - selection of only devices of interest.

The Timeline application allows you to work with selections containing up to 1,000,000 events, which,
as a rule, is redundant for a qualitative analysis of the situation. It is recommended to limit the
selection as precisely as possible before it is formed, in order to reduce the amount of unnecessary
information in it (which will still bother you), as well as the time required to acquire it (especially over
the network) and pre-processing.

After all limits are configured, click the Continue button. The application will proceed to
the process of acquiring a selection from the database, taking into account the limitations you
have entered, after which the data of the acquired selection will be presented on the screen in
the form of a table.

When working with a database, the Refresh command is available in the Selection menu, which allows
you to quickly see what new items that satisfy the selection parameters have appeared in the database
since the last update.
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6.2.2 OPENING DATA FILES

To open a file, you must execute the Open file command from the main menu.

When opening a data file, as well as when connecting to a database, selection must be
made. The only difference is that the data is not taken by connecting to the Archive service, but
directly from the specified file.

After selecting the necessary data file, its preliminary analysis will take place. The time
taken for this operation depends on the file format and the number of events in it. After the
analysis, the elements of the selection limitation will be shown on the screen, and then
everything follows exactly the process described in the previous paragraph.

Timeline supports the following data file formats:

File mask

*.db

* datapak

*.dbbackup

*.archive

Description

Database format that stores data of one of the types acquired from
BE2704/ED7 and BE2502/ED5 IEDs for one calendar month. It was used as the
only data storage format until the release of EKRASMS 2.9. Supported event
types: Internal events, Binary signals and FLOC. To open files in this format, it is
desirable to have device description files (*.dcf/*.ccf), the events of which you
are interested in. Otherwise, you will see only the numbers of binary signals,
without names, and information about the device will be limited to its serial
number.

EKRASMS 2.9 — 2.13 selection format. The file may have been acquired by
saving the selection in the Timeline application of these versions of the packet.

A compressed copy of the EKRASMS 2.9 — 2.13 database. The file may have
been acquired using the Arsenal application of these versions of the packet.

A compressed copy of the ERKASMS 2.14 database and newer. The file can be
acquired in Arsenal by saving the database as a file in the Archive service menu
or from a backup via the backup management window of the Backup service.

Also, the Open file command allows you to open selections previously saved in the application in files
(*.timeline). This is the application's own selection format, in which, in addition to the data, all settings
made are also stored. This allows later to continue analyzing the data from the state in which they
were at the time the file was saved. The opening of such files occurs without the stage of selection

limitation.

6.3 WORKING WITH SELECTION

The Timeline application allows you to view events as a table, sorted by the time of their
occurrence in ascending order.

6.3.1 SELECTING COLUMNS TO DISPLAY

Using the list from the View > Columns menu, you can select which columns will be shown

in the table.

The following columns are available:
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Name Description

No. Number of the event in the table
Date Date of event occurrence by the device clock
Time Time of event occurrence by the device clock
To next event Time until the next event in the table
Type Type of the event (internal, binary signal, etc.)
Category Category within the type that the event belongs to (not all types are categorized)
Event Name of the event
Value Value of the event (if the event has one)
Index Index of the event in the device recorder (if the event has one)
Device Factory number of the device
Series Series of the device
Firmware Information about the device firmware
Hardware Hardware version of the device
Device name Name of the device
Location Location of the device

Using the View > Columns > Remember table layout command, you can save the
composition of selected columns and their widths. This view will be automatically applied when
opening new selections in the future, with the exception of selections from *.timeline files, which
themselves store all information about their appearance.

6.3.2 SETTING TIME REFERENCE POINT

In the Timeline, you can control the reference point when displaying time in the Time
column. By default, this column shows the absolute time the event occurred, but by setting the
reference point to a specific event, you can force the application to display the time elapsed since
or before that moment. This is convenient, for example, when analyzing a process, when
absolute marks are not of great importance, but time intervals from the beginning of a process to
a specific event are important.

To set a reference point, place the cursor on the line that you want to take as the origin of
the reference and execute the Set reference point command in the View menu or the context
menu of the table.

To reset the reference point and return to displaying absolute time values, execute the
Reset reference point command in the View menu or the context menu of the table.

To quickly search for a line on which a reference point is set, execute the Find reference
point command in the View menu or the context menu of the table.

6.3.3 INTRODUCING TIME SHIFTS BETWEEN DEVICES

Devices generate events based on their own clock. In general, the clocks of different
devices, the events of which transferred to the same database, may not be synchronized, which
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is unacceptable when the analysis of the situation requires simultaneous use of events from
several devices.

Timeline allows for each selection device to enter a numerical time shifts in the range of
+/-100 hours.

To enter shifts, you need to execute the View > Time shifts command, which will display a
window with a tree of devices, for each of which you can specify a shift by double-clicking on the
device line in the Shift column.

The window for specifying shifts contains a device search line by name or number, which
is convenient when there are dozens or even hundreds of devices in the selection.

The time shift between the clocks of two devices, in the absence of global synchronization, the value is
not constant. As a rule, due to the discrepancy between the parameters of quartz oscillators, the
difference increases with time, so the shift determined for a certain point in astronomical time may be
completely inapplicable to points in time that are several hours and sometimes minutes away from it.
Thus, the necessary shift must be determined from the events of each process that is to be analyzed.

6.3.4 TABLE NAVIGATION

Selections may contain hundreds of thousands of events. In order to move faster through
this amount of data, the Timeline has a number of special mechanisms.

SWITCHING TO DATE

If the selection contains events for more than one calendar day, a calendar bar is
displayed above the table to quickly jump to the beginning of the day of interest by clicking on it.
This calendar displays only those days for which there are events.

View > Calendar menu commands allow you to control visibility of the calendar bar.

SEARCHING FOR REPETITIONS OF SAME EVENT

By placing the cursor on the line with the event of interest, you can quickly find previous
or subsequent occurrences of the same event. To do this, use the Find same event earlier/later
commands from the Search menu or context menu of the table.

SEARCHING FOR EVENT BY NAME

In the right part of the menu bar there is an entry field for searching an event by name.
Enter the required part of the name in the bar, press Enter, and if there is an event in the table
after the actual bar that contains the entered text in the name, the cursor will move to it. If you
want to continue searching further, press F3. When the end of the table is reached, the search
moves to its beginning.

6.3.5 BOOKMARKS

Timeline allows you to bookmark the actual table row so that you can quickly return to it
later. Multiple rows can be bookmarked. Bookmarks are named. By default, the bookmark is
given the name of the event, the row of which it marks, but you can also specify your own names
that are convenient for you. Rows with bookmarks are displayed in yellow.

The Bookmarks menu is designed for working with bookmarks.

CREATING BOOKMARK

To create a bookmark, place the cursor on the required row of the table and execute the
command of choice:
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— Create from the Bookmarks menu;

— Add bookmark of context menu of the table.

SEARCHING FOR BOOKMARK

To search for a bookmark, you need to open the Bookmarks menu and double-click on the
bookmark of interest, focusing on its name and time stamp.

EDITING BOOKMARK NAME

Ways to edit the bookmark name:

— Place the cursor on the row with which it is associated and execute the Edit bookmark
command of context menu of the table;

— Find the bookmark in the Bookmarks menu list and select Edit.

REMOVING BOOKMARK

Ways to delete bookmarks:

— Place the cursor on the row with which it is associated and execute the Remove
bookmark command of context menu of the table;

— Find the bookmark in the Bookmarks menu list and execute the Remove command;

— To remove all bookmarks, select the Remove all command from the Bookmarks menu.

6.3.6 FILTERING EVENTS

Timeline allows you to temporarily hide (filter) events in the table.

You can hide individual events, entire devices, as well as events related to certain types
and categories.

The Filter menu commands are used to perform filtering functions.

The filter is most fully configured in the Filter window, which is called by the Filter >
Setup command.

FILTERING BY EVENT TYPES AND CATEGORIES

The Types and categories page of the Filter window contains a tree of event types and
categories. By unchecking the items in this list, you hide the events of the corresponding types
and/or categories. Types and categories, the events of which are not in the selection, are not
available for checking and are displayed in gray.

FILTERING BY DEVICES AND INDIVIDUAL EVENTS

In the left part of the Devices and events page of the Filter window there is a tree of
devices. By unchecking the elements of this tree, you hide all events of corresponding devices.

The right side of the page contains a list of events of the device selected in the device tree
that are present in the selection. By unchecking the items in this list, you hide specific events for
this device.

Above the device tree and above the list of events there are search bars by name (and for
devices by number).
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FILTERING BY NAME

On the Names page of the Filter window, you can enter a fragment, or several fragments

separated by the ";” symbol (semicolon) of the event name. Only events the names of which
contain the entered fragments will be displayed in the table.

ADDITIONAL COMMANDS FOR WORKING WITH FILTER

In addition to direct filter operation in its settings window, Timeline contains several
more commands that change it, but work in the context of the actual table row and allow you to
quickly hide individual events or devices. These commands are available from the Filter menu
and from the context menu of the table.

The Hide all events except current command allows you to quickly leave only the
occurrences of the current event in the table.

The Hide current event command, on the other hand, allows you to quickly hide all
occurrences of the current event.

The Hide all devices except current command allows you to quickly leave only the events
of the device that generated the current event in the table.

The Hide current device command, on the contrary, allows you to quickly hide all events
of the device that generated the current event.

LIMITING DISPLAYED TIME RANGE

On the Time range page of the Filter window, you can explicitly limit selection by time,
both from the beginning and from the end. In addition, the menu has a number of commands
that allow you to perform this operation faster.

The Hide all before/after current timestamp commands available both in the Filter menu
and in the context menu of the table allow you to quickly narrow the time interval of displayed
events. Select the event the time stamp of which you want to make the limit of the displayed
time interval and execute one of these commands.

The Filter > Reset visible time range command allows you to disable previously entered
time limits.

DISABLING AND RESETTING FILTER

If the filter is active, then below, under the table of events, a yellow line is displayed with
a reminder of this. This line also contains the Filtered only and All events buttons, which allow
you to quickly switch between a filtered set of events and a full set of events.

The Filter > Reset menu command allows you to completely reset the previously
configured filter and return to the full set of events.

6.3.7 LINKED FILES

An event can be linked with a file (for example, a oscillogram), while an arrow appears to
the right of its value in the Value column, clicking on which opens the menu for working with the
file. From here, the file can be Saved to disk or Opened in a program designed to work with files
of this extension.
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6.4 WORKING WITH THE DIAGRAM

The diagram panel is located in the lower part of the selection window and is intended
for drawing time diagrams of events. After creating a selection, the diagram is empty, but it can
be filled with events as needed.

The diagram has its own menu bar. Further in this section, all commands, unless otherwise noted, refer
specifically to this menu.

6.4.1 EDITING EVENT COMPOSITION ON DIAGRAM

Using the Events window, which opens when you execute the Diagram > Select events
menu command, you can check the boxes for events that you want to see on the diagram.

The Diagram > Select events from table menu command allows you to add events to the
diagram that fall within the range selected with the mouse in the table. The command puts the
table in the event range selection mode and temporarily hides the diagram. In this mode, it is
necessary to select the range of events of interest by two successive clicks on the rows of the
table and click the Execute button in the yellow line at the top. After that, all events that fall into
the selected range will fall on the diagram. If you have selected the wrong event range, click the
Reset button, which will allow you to mark the range again.

It is important to understand that in the context of this command, the Range term has nothing to do
with a time interval. The diagram shows events for the full time interval of the entire selection.

The Diagram > Show all events from table menu command allows you to quickly add to
the diagram all events that in the table now.

Using the Add to diagram command from the context menu of the table, you can add
events to the diagram one at a time. A similar action can be performed by dragging the desired
row of the table onto the diagram.

You can quickly remove an event from the diagram by clicking the cross in its right part.

6.4.2 CURSOR AND ACTUAL MOMENT

On the diagram there is a concept of the actual moment. It is specified by the cursor
(vertical red line), which is always present in the display area of the diagram graphs and which
can be moved along the time axis. The cursor title displays the time stamp of the actual moment.
The actual moment is used to display the value of the event on the diagram.

Ways to move the cursor:

— Drag with mouse. At the same time, a yellow trail follows the cursor, which indicates the
offset in milliseconds relative to the previous position;

— Left click in the event graph display area moves the cursor to the point in time
corresponding to the click location;

— Left and Right keys move the cursor left and right one step;

— SYNC button turns on the mode in which the cursor in the diagram follows the selected
line in the event table.

45



EKRASMS

time range in the width of the window.
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6.4.3 TIME SCROLL

Ways to scroll the diagram by time:

— Using the time scrollbar (at the bottom of the diagram window);

— Shift + Mouse scroll;
— Keyboard:

Keys
Shift + Left
Shift + Right
Shift + Page Up
Shift + Page Down
Shift + Home

Shift + End

6.4.4 TIME SCALING

Time scaling methods:

Action
Smooth scrolling to the left
Smooth scrolling to the right
Page scrolling to the left
Page scrolling to the right
Scrolling to the beginning of the diagram

Scrolling to the end of the diagram

— The Zoom in/out time buttons of the toolbar;

— Ctrl + Shift + Mouse scroll;

— Keyboard:
Key
Ctrl + Left

Ctrl + Right

Action

Zoom in

Zoom out

— The MAX button (Set the maximum time scale) in one click sets the maximum possible
time scale;

— The MIN button (Set the minimum time scale) in one click sets the minimum possible
time scale.

— The AUTO button (Fit to window) in one click sets scale, allowing you to fit the entire

6.4.5 SCROLLING EVENT LIST

Ways to scroll the list of events:

— Using the vertical scrollbar of the list;

— Mouse scroll;

— Keyboard:



Key Action

Up Smooth scrolling up

Down Smooth scrolling down

Page Up Page scrolling up

Page Down Page scrolling down

Home Scrolling to the beginning of the list
End Scrolling to the end of the list

6.4.6 MOVING EVENTS

To move an event, you need to grab its name with the mouse and move it to a new
location. While moving, a blue horizontal line represents the insertion point.

6.4.7 SORTING EVENTS

The Diagram > Sort menu command allows you to quickly arrange events on the diagram
in ascending order of devices factory numbers and in alphabetical order within one device.

6.4.8 MARKERS

Named markers can be added to the diagram to mark points in time that are important
for analysis.
To work with markers, use the Markers menu.

ADDING

Ways to add a marker:

— The Markers > Create command adds a new marker to the actual position of the (red)
cursor;

— Shift + Left click adds a new marker to the position with a time point corresponding to
the place of the click.

MOVING

The marker can be moved along the time axis by grabbing it with the mouse. When the
marker is moved, a trail follows it, showing the offset in milliseconds relative to the previous
position.

If you capture the marker while holding down the Shift key and start moving, then the
marker itself remains in place, and the newly created marker moves and the trail, which at the
same time stretches behind the new marker, shows an offset relative to the original marker. This
feature is useful when you want to add a new marker that is a certain amount of time away from
the existing one.

SEARCHING

To search for a marker, you need to open the Markers menu and double-click on the
marker of interest, focusing on its identifier and time stamp.
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EDITING PARAMETERS

Ways to open the marker parameters window:

— Markers > Edit command. In this case, the required marker must be selected from the
list that appears. In the list, a marker is represented by its identifier;

— Edit command of context menu of the marker;

— Double click on the required marker.

REMOVING

Ways to remove the marker:

— Markers > Remove command. In this case, the required marker must be selected from
the list;

— Markers > Remove all command. Removes all markers added to the diagram at once;

— Remove command of context menu of the marker.

6.4.9 INTERVAL TABLE

The Intervals button allows you to enable or disable the display of the table of intervals
between the markers placed on the diagram.

6.4.10 EXrOoRT TO COMTRADE

The diagram can be saved in Comtrade format for joint analysis with oscillograms in
Waves.

Only binary signals are exported as Comtrade. All other types of EKRA device events cannot be
described by means of this standard.

To perform an export, execute the Diagram > Export menu command and select the
required version of the Comtrade standard in the submenu. Additionally, in the Export
parameters, you can specify the encoding of the configuration file and the format of the data file.
The sampling rate of the resulting file is 1000 Hz.

You can export in Comtrade file for not more than 5 minutes, so the export parameters
have fields that specify the Begin and End of range using markers.

6.5 PRINTING EVENT TABLE

The Selection > Print command allows you to print the table of events. When the
command is executed, a preview window opens.

The Printer settings button allows you to select a printer, configure printer settings,
specify page parameters, and select a print mode. The Print parameters button allows you to
specify a number of additional design options. The results of parameter changes can be
immediately seen in the preview area.

Only those events that are currently visible in the table are printed. Events hidden by
filtering are not printed.

By default, the entire selection range is printed, but it can be limited by setting two (one,
if it is necessary to limit on one side only) bookmarks that set the limits and selecting them in
the Printing parameters window.
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6.6 SAVING SELECTION

The selection is saved in the application's own format, *timeline. All selection events are
saved, as well as all display and filtering settings made during the analysis. Therefore, when you
later open such a file, you will continue working from the point where you interrupted it at the
time of saving.

To save an open selection, use the Save and Save As commands from the Selection menu.

The Save as command always prompts you to specify the path and name of the file in
which the save will be made.

The Save command works either the same way if the selection is from a database or data
file and has never been saved before, or it saves the file under the actual name if the selection is
opened from a *timeline file or has been saved at least once before.

The application allows you to save to the *timeline file only filtered events, those that are
currently visible in the table. This allows you to get a more compact file, without everything that
turned out to be superfluous in the process of analyzing a certain situation. To perform such a
save, you must execute the Selection > Save filtered command.

6.7 EXPORTING SELECTION TO CSV

To export the event table in CSV format, which can later be opened in Microsoft Excel or
processed by your own programs, you must execute the Selection > Export CSV command. Only
those events that are currently visible in the table are exported. Events hidden by filtering are
not exported.

6.8 MERGING SELECTIONS

Timeline allows you to merge multiple selections into one. In this case, a new
independent selection is formed. To perform a merge, you must open all the selections you want
to merge and execute the Merge selections command from the main menu. In the window that
appears, check boxes of selections which need to be merged and, if necessary, check the Merge
only filtered events box if you want only filtered events in the merged selections to be included in
the merger.

A selection cannot contain more than 1,000,000 events, so if the total number of events in the
selections to be merged exceeds this figure, the merging will fail. If you encounter a similar situation
and still want to merge, you need to apply filtering and merge only filtered events.

6.9 GLOBAL SETTINGS OF APPLICATION

The Settings command of the main menu allows you to customize the appearance of the
application for new selections.

The Associate files command allows you to rebind the extensions of the event files
processed by the program if the binding created during installation was reset or changed for
some reason.
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7 ATLAS. SETTING ANALYSIS

7.1 FUNCTION

The Atlas application allows you to view the settings of BE2704/ED7 and BE2502/ED5
series IEDs saved in files of the following formats: SFR, DFR, MIX, ALL, PR, AD], OSC, BIN, UBN,
UBN2.

7.2 WORKING WITH APPLICATION

The application allows you to open several settings files at the same time: each settings
file will be displayed on a separate page.

It is possible to compare two loaded settings files: names, descriptions of settings and
their values are compared. Based on the results of the comparison, a report is issued.

Also in the application there is an Export function, which allows you to save the settings
as an HTML document.

An HTML document can be opened for editing in Microsoft Word. To do this, you need to start Word,
execute the Open command and select the created HTML document with settings. After editing, you
can save the result in native Word format. To do this, you need to execute the Save as command and
select the saving format you are interested in in the dialog.
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8 MiX. SERVICE MAINTENANCE OF IEDsS

Service maintenance of BE2704/ED7 and BE2502/ED5 series IEDs is a responsible
process: incomplete or incorrect execution of actions in the servicing process can lead to
incorrect operation of the IED, therefore, before starting service, you should carefully read this
section and understand the concepts and processes that are described in it.

8.1 WHAT IS “SERVICE MAINTENANCE”

Service of BE2704/ED7 and BE2502/EDS5 series IEDs includes the following actions:

— updating firmware in the IED;

— editing the image (settings, name table, programmable logic etc.) in the connected IED;
— acquiring a full backup of the IED and restoring the IED from the backup;

These actions are performed using the Mix application. In this case, the IED is taken out of
the normal operation mode and switched to the service mode.

8.2 BASIC CONCEPTS

In order to fully work with IEDs of BE2704/ED7 and BE2502/ED5 series in the service
mode, it is necessary to understand the definitions and concepts that are outlined in the
following sections.

8.2.1 FIRMWARE

IEDs of BE2704/ED7 and BE2502/ED5 series can contain one or more processor units.
Each unit runs its own internal microprogram. Each such microprogram on the computer is
represented as a file with the bin, ubn or ubn2 extension (depending on the IED hardware
platform). Firmware is a set of microprograms for all units of the IED.

In all IED service scenarios that involve the use of firmware (for example, updating
firmware in the IED), a full set of microprogram files included in this firmware is always
required. Replacing the microprogram in only one unit and refusing to replace the
microprogram in other units will result in incorrect operation of the IED.

8.2.2 IED IMAGE

The IED image contains a copy of the data of all regions of the [ED memory.

The image is a file with the mix extension.

The image can be generated on a computer based on the firmware or read from the IED
itself.

If the image is generated based on the firmware, then the settings in this image will have
default values, the name table and the programmable logic will initially be empty.

If the image is generated by reading from the IED, then such an image will be an exact
copy of all regions of the IED's memory.
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8.3 WHAT IS “FIRMWARE UPDATE”

Firmware update refers to the process of replacing internal microprogram in all
processor units of the IED, as well as preparing the settings existing in the I[ED, name table, the
programmable logic etc. for correct operation with the new firmware.

Due to the peculiarities of implementation of BE2704/ED7 and BE2502/ED5 series IEDs,
it is impossible to replace only the firmware itself and continue using the IED. The old and new
firmware may have different sets of binary signals. In addition, a signal with the same number
can change its purpose; new settings may appear, the parameters of existing settings may
change (e.g. ranges). The name table and the programmable logic will cease to function if you
simply change the firmware in the IED. Therefore, the conversion of the existing contents of the
IED to the new firmware is required. This conversion process is called adaptation.

8.4 SWITCHING IED TO SERVICE MAINTENANCE MODE

In order to switch the IED to service mode, it is necessary to supply power to it by
holding down buttons « + 1 + - on the front panel.

Service maintenance of the IED should be carried out through the USB port on the front
panel.

In order to connect to a USB port, you need to install the virtual serial port driver from the site
https://dev.ekra.ru.

8.5 SERVICE MAINTENANCE SCENARIOS

8.5.1 UPGRADING FIRMWARE

To update the firmware, you need to start Mix, execute Upgrade device firmware
command in the initial window and follow the instructions of the wizard. During the wizard
operation, the actual image will be read from the connected IED and adapted to the new
firmware, after which Mix will display the image window, which is ready to be written to the
IED. At this stage, it is highly recommended to review all memory regions and check the results
of adaptation. After you are sure that the new image is correct, you must execute the Write to
device command and follow the wizard's instructions.

8.5.2 EDITING DEVICE CONTENTS

Mix allows you editing the settings, name table and programmable logic in the connected
[ED without changing the firmware. You need to start Mix, execute Edit device contents command
in the initial window and follow the instructions of the wizard. After Mix reads all the necessary
information from the IED, the image window of this [ED will be displayed on the screen.

It should be remembered that in some types of IEDs, the name table and the diagram of
programmable logic are combined into a single User settings region.

A number of actions are available for each memory region. If the memory region allows
editing, then the corresponding command will be available in the action menu, which opens the
editor window. Memory region editors are described in more detail in the following sections.

Some memory regions also allow importing data from files of outdated formats.
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After editing is completed, you can write the changes back to the IED: to do this, you need
to execute the Write to device command and follow the instructions of the wizard.

8.5.3 BACKING UP AND RESTORING IED

Using the Backup device command, you can create an image file that will be a complete
and exact copy of all regions of the I[ED's memory. This image can then be used to restore the IED
using Restore device command.

The Mix backup and restore wizard will sequentially connect to all processors units of the
IED and read all memory regions available in these units.

8.6 EDITING MEMORY REGIONS

Each editor has a Close editor command. Running this command will return you to the
IED image window. If changes were made in the editor, then they, at will, can be made to the
image or canceled.

All editors have infinite undo and redo capabilities. Only the settings editor, for technical
reasons, does not have this capability.

8.6.1 EDITING SETTINGS

In the left part of the editor there is a tree with a hierarchy of parameters, and in the right
part there is a list of parameters in the selected of the tree node. To change the value of a
parameter, double click its actual value (or press the Enter or F2 keys). The changed parameter
value is displayed in bold; in addition, icons may appear on the right and left of the cell with the
parameter value, indicating that the value is read-only or that it is out of range. Hover your
mouse over the icon for a hint.

Some parameters may have values in primary and secondary values. When you change
one of the values, the second one is recalculated automatically. When changing the
transformation ratios, the dependent values are also automatically recalculated.

The Setting groups menu, available for [ED images containing multiple setting groups,
allows you to control the visibility of setting values in different groups. The editor can show
values only in the working group, only in the selected group, or in all groups at once.

8.6.2 EDITING NAME TABLE

Parameters of some configuration elements of the IED can be renamed. New names are
stored in the Name table memory region.

The IED firmware developer determines exactly which configuration elements are
available for renaming.

As a rule, one can assign the element a new Name, which is used in EKRASMS
applications and services, a name for the indicator, which is displayed on the IED display, and, in
some cases, names of the possible values of the selected parameter.

To change a parameter, press Enter, FZ, or double click it. Specify a new value. Some
character spaces may not be editable - they are displayed in red.

If a new value is specified, then a button with an arrow will appear in the line, clicking on
which you can return to the original value.

8.6.3 EDITING PROGRAMMABLE LOGIC

I By adding a programmable logic to the IED, you assume responsibility for its correct operation.
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The editor window is divided into three areas:

— in the left part of the window there is a library of logic elements; using the mouse, they
can be dragged to the scheme workspace;

— on the right there is a scheme workspace; the size of workspace can be increased using
the corresponding toolbar command;

— there is a message window in the lower part: in case of errors in processing the
scheme, corresponding messages will be displayed here; if you double click a message, the error
element on the diagram will be selected.

The IED uses the method of synchronous execution of the logic scheme, i.e. in one
working cycle, it calculates all logic elements sequentially, element by element. For the correct
calculation of all elements by the IED, the Mix application, in the process of drawing a scheme,
ranks the elements of the diagram: each element is assigned a rank, then the elements are sorted
in ascending order of their ranks. The sequence of elements formed in this way is transmitted to
the IED. The “input port” elements are assigned a rank of 0; the assignment of ranks to
remaining elements is done in such a way that the state of i element is calculated only after the
states of all elements that are connected to the inputs of i element are calculated.

If there are closed circuits (feedbacks) in the circuit, the complete ranking of the circuit
becomes impossible. Consider an example, the diagram of which is shown in the figure.

|
D1 D2 03
D4 1 1
#1
D5
#2

The system of unranked logic equations for this diagram is as follows:
D2 =NOT (D1 OR D5)
D1 =NOT (D2 OR D4)
D3=D2

It is not possible to determine the ranks of elements D1 and D2, since the states of both
elements depend on each other. In this case, the message There is one or more unmarked
“feedbacks” among elements D1, D2, D3 will be added to the Messages panel at the bottom of the
Mix application window.

To enable such diagrams, conditional ranking is used: the closed circuit is broken, and the
rank of 0 is assigned to the break point. In this case, it is necessary to specify some initial
condition at the break point. In IEDs of BE2704/ED7 and BE2502/ED5 series, such a condition
at the initial moment of time is a logical zero. Using the Mix application, conditional ranking is
implemented as follows: it is necessary to designate the broken circuit as feedback (FB). To do
this, select the appropriate tool from the main or context menu and place it on the network to be
broken:
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The circuit that is connected to the FB element is highlighted with additional dotted lines.
Then the ranked logical equations for the feedback circuit will look like this:
D1 =NOT (D2 OR D4)
D2 =NOT (D1 OR D5)
D3 =D2
At the initial moment of time, the state of the circuit marked by the FB element and
formed by the output of the D2 element is assumed to be logical zero. Then it becomes possible
to calculate the state of the D1 element (since the states of all its inputs are known), and then DZ2.
This will remove the corresponding warning about unmarked feedback from the Messages panel.
The principles of working with the graphic editor of the programmable logic are similar
to those used in most modern graphic editors of diagrams, however, there are the following
features:

— to transfer an element from the library to the workspace, you just need to drag the
desired element onto the workspace. The element will automatically receive a certain sequence
number (numbering of all circuit elements is performed automatically according to the principle
from left to right and from top to bottom);

—double clicking on a logic element opens the window of element's properties.
Properties have time delays (they need to specify a time delay value in milliseconds) and binary
signal input/output ports (they need to be assigned a binary signal, and output ports can also be
assigned a new name for this signal);

— simple intersection of two separate conductors does not automatically connect them
into one circuit - to do this, you need to place Junction at the intersection;

—in the process of drawing a scheme, the number of elements and links used is
constantly monitored. If any counter exceeds the maximum number (see the table below), a
corresponding warning is added to the Messages panel.

Element type Maximum quantity
Operation time delay 50
Release time delay 50
Two-input logic 256
Three-input logic 256
Output 256
Links between elements 512
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There is also a limit on the amount of memory occupied by the programmable logic in the
ROM of the IED, which is 1,024 bytes. Therefore, even without exceeding any restrictions on the
number, on some diagrams, you may encounter the impossibility of placing the created
programmable logic in the device. The actual memory usage is also displayed at the bottom of
the program in real time.
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9 DUMP. APPLICATION PERFORMANCE ANALYSIS

9.1 FUNCTION

EKRASMS services and applications keep a log of their work. This log is necessary to
analyze abnormal situations that occur with programs and search for errors.

The Dump application is designed to view the EKRASMS log. After opening the
application, the local log opens automatically.

I The information in logs is only relevant to developers, so there is no description of how to interpret it.

9.2 LOG TRANSFER TO DEVELOPER

If you encounter problems related to the operation of programs of EKRASMS package,
you should send an e-mail to dev@ekra.ru, in which you describe the problem in as much detail
as possible, including attaching the necessary screenshots or video files. It is also necessary to
attach a system log file for the period when the problem was discovered.

To get a log file (*.dump), you need to execute the Save command and specify the time
period for which you want to get the log.
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10 WORKSTATION. DUTY OPERATOR AWS

10.1 FUNCTION

Workstation is designed to create and configure graphic screens of an automated
workstation (AWS) of a duty operator and monitor the actual mode of operation of a power
facility (station or substation) on which BE2704/ED7, BE2502/ED5 and BE2702(M) IEDs are
installed.

The application is described in more detail in document 3KPA.00004-01 90 01 “APM
JedxcypHozo”.

58



